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Overview 

Web Questionnaire is an easy to use tool that makes quick work of creating 
simple questionnaires and publishing to your websites. Questionnaire replies 
are retrieved via emails . 
 
WQ’s powerful features include:  

• WYSIWYG questionnaire editor makes questionnaire editing simple.  
• Integrate with Outlook/Outlook Express/Eudora seamlessly to retrieve 

questionnaire replies.  
• Choose from 30 available HTML templates for creating great looking 

questionnaires easily.  
• Choose and modify from dozens of built-in questionnaire libraries.  
• Save frequent used questions to library questions.  
• Question validation to ensure the specific question is not answered.  
• Various report format: HTML/Bar/Bar3D/Line/Line3D/Pie/Pie3D.  
• No Monthly fees, no additional respondent fees.  
• No JSP/PHP/ASP required. Does not need any DB or CGI to handle the 

replies.   
 

System Requirements 
OS: Win98, Win2000, WinXP 
Browser: IE5 and above 

 
 

Questionnaire View 

To create a new questionnaire, simply click the New toolbar icon or select New 

from the File menu in the Questionnaire view. You can then select the 
questionnaire template that you want to use from the Form menu. By default 
the ‘untitled’ template is chosen, this gives the greatest flexibility over 
questionnaire design. If a predefined template is chosen it can be modified to 
suit the type of questionnaire you are designing.  
 

Select the questionnaire template 
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If the predefined template selected contains predefined macros, a dialog 
pop-ups to let you specify the value. For example, the URL of a website or the 
company name. 
 

Specify the values for predefined macros 

 

 
You could then choose the HTML template you would like to use. 
 

Select the HTML template 

 

 

Tree Layout View 
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The Tree Layout View is used to design the questionnaire. Double click on the 
top-most node, you can set the properties. Right clicking on the tree nodes 
allows the addition of questionnaire components: pages, questions, select 
items and comment items. The Windows drag and drop is fully supported 
within the application. 
 

Questionnaire 
 
The top-most node represents the questionnaire that your are editing.  
You could change the following properties for the questionnaire: 
 

Edit Questionnaire properties  

 

 
Title— The HTML title that will appear when the questionnaire is sent as a 

HTML attachment.  
 
Logo— The image that you could put on the top-most of the questionnaire. 

Usually, it is an image file of your company logo. 
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Set Logo as Link—  Sets the URL property of your logo. Therefore, when 

users click on your logo, the browser will navigate to the URL specified.  
 
Redirect URL— By default, a “Thank you” page will appear after users click on 

the submit button of the questionnaire. However, you may display your own 
HTML pages if necessary. Put in the URL of the HTML page in this field and it 
will appear after the questionnaire is submitted. 
 
Submit button text—  By default, WQ displays “Submit” as the name of the 

button for the next page. You could change to the corresponding string of your 
preferred language. 
 
Reset button text—  By default, WQ displays “Reset” as the name of the 

button for the previous page. You could change to the corresponding string of 
your preferred language. 
 
 

Multiple Pages properties  
  
WQ allows you to create a questionnaire that spans multiple HTML pages. 
Therefore, you could split a huge questionnaire into several smaller 
questionnaires. In this way, the recipient will be more willing to answer your 
questionnaire since your questionnaire is well organized.  
However, if your questionnaire is exported as multiple HTML files, you could 
not load the questionnaire from your hard disk. The only way you could test if 
the questionnaire works is to export it or copy the files to your website, and load 
the questionnaire directly from the URL of your website.  
  
Publish as Multiple Pages— (*Only available in the Enterprise version. *)   

If selected, the questionnaire exported will be spited into separate HTML pages 
according to the number of page you create. WQ will generate the files using 
the name questionnaire.html, questionnaire1.html, questionnaire2.html, ...etc. 
Do not change the file name of the separate HTML file, since WQ depend on 
the file name in order to work properly.   
 

Multiple Page Properties  
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URL— Specify the directory that your questionnaire will be published. This is 

very important since WQ utilizes this setting to connect one HTML page from 
another. If you give incorrect setting, you will not be able to submit the 
questionnaire correctly.  
 
Next page button text—  By default, WQ displays “Next’’ as the name of the 

button for the next page. You could change to the corresponding string of your 
preferred language. 
 
Previous page button text—  By default, WQ displays “Back” as the name of 

the button for the previous page. You could change to the corresponding string 
of your preferred language. 
 
The questionnaire needs to be answered in the correct order from the first page to the last. 

Otherwise, a HTML page will appear to notify you that the order is not correct and the 

questionnaire needs to be restart from the first page.  

  

A warning page that the questionnaire is not answered in correct order  
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Questions 
 

Questions represent the fundamental components of the questionnaire. Add 
new questions by right clicking on the page node in the tree layout view and 
selecting Question or Question Library. For more information, see Question 
Creation. 

 
Select Items 
 

Each question can contain select or comment items. Select items require 
a response from the recipient of the questionnaire and are included in the 
generated reports. For example “checkboxes” are one type of select item. Add 
new select items by right clicking on question nodes in the tree layout view. Six 
different types are available. Once the select item type is chosen, you can use 
the Answer Library to enabled the “pre-canned” responses or design your own. 
For more information, see Select Item Creation. 

Select items supported by Web Questionnaire  
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Comment Items 
 
Comment items are used for designing the form but do not participate in the 
generated reports. E.g. pictures. Add new comment items by right clicking on 
question or page nodes in the tree layout view. 
 
Three types of comment items are supported: Labels, Separator, and Images. 
The examples of these comment items are listed below: 

Example of Using Label Comment Item 
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Example of Using Separator Comment Item 

 
 

Example of Using Image Comment Item 

 
 
Question Creation 
 
The questionnaire is designed and edited through the tree layout. Right click 
the page node and select Question. The Question Properties dialog box will 
then appear. Select the desired number of questions and edit the question text 
in the “Edit Question” view.  

Add a question from the page node 
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The Question Properties dialog box 

 

 
Another way to create questions is to right click the page node and select 
Question Library. You can then select some pre-defined questions. The 
question library is classified into six predefined categories, plus the 
user-defined one. You can traverse and select the questions you want to add.  
If the question must be answered before submission, you could enable the 
option for “Must have answer”. If respondent does not answer it correctly, a 
warning message will be displayed. 
 

Add questions from the predefined Question Library 
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The questions can be edited later if required by right clicking or double clicking 
on the question in the tree layout view after it has been added to the 
questionnaire. This will enable the properties form. 

 
The question font can be changed one at a time or as a batch. Checking the 
checkboxes to the left of question nodes in the design tree will allow the batch 
option to be used. Change the font in the Question Properties dialog box, and 
then select Apply To All Checked Nodes in Design Tree on the question 
property form. 
 
You can adjust the layout of questions by selecting Next To Previous on the 
Position page in the Question Properties dialog box. Questions will be placed 
on a horizontal pane next to the previous question. Alignment can align the 
question in the center, left, or right of the questionnaire.  
 
To edit the question, simply double click it or use the right mouse button on the 
tree node and select “properties”. To delete the question, select Delete after 
right clicking.  
  

Select Item Creation 
 
Right click on the question node in the design tree and choose Select from the 
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popup menu. After choosing a select item the Properties dialog box will appear.  
Most Select items include property pages for General, Font and Position.  
 

Create a select item 

 
 

For Text/TextArea, two options are available for them. If “Reply must have 
value” is selected, user must type in his answer in this select item. If “Set as 
ID” is checked, the answer of this select item is regarded as a user id, which 

will be displayed in the Survey View. Type Checking property is for format and 
range checks. 
 

Add a Text item 
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List, Checkbox, Radio and Matrix select types can take advantage of the 
built-in Answer Library to make adding select items easy. You can change the 
settings of select items at any time by right clicking on the select node and 
selecting Properties. 
 

Add answers from the Answer Library  

 
Select the answer that you need and add to your questionnaire  
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For more information, see Text Properties Setting, Checkbox Properties 
Setting, Radio Properties Setting, List Properties Setting, Matrix Properties 
Setting and TextArea Properties Setting. 
 

Common Item Properties 
 
Setting common Select/Question item properties. 

Change properties for the common items 
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General page 

Set the description/label for the current item. 
 
Background Page (only for question properties) 

Set the background color of the item. 
 
Apply To All Checked Nodes in Design Tree 
For Background and Font pages only. Change the font and color for all 
checked nodes in the design tree. 
 
Font Page 

Set the font/color for the item. 
 
Apply To All Checked Nodes in Design Tree 
For Background and Font pages only. Change the font and color for all 
checked nodes in the design tree. 
 
Position Page 

Alignment—  Align to  the center, left or right. 
 
Next To Previous—  Place item on horizontal pane next to the previous select 
item for the current question. 
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Example of using “Next to Previous”option 

 
 

Steps to change “Next to Previous” property 

 

 

Setting Text Properties 
 
Use the General page to set the number of select items and edit their labels. 
Set the font and color of the label on the Font page. You can also change the 
font and color of all checked nodes in the design tree. On the Position page, 
adjust the alignment and layout of select items. Alignment puts the item in the 
center, left, or to right of the page. Checking Next To Previous will place this 
select item on horizontal pane next to the previous select item for the current 
question. 
 
Must have answer —  Disable the questionnaire submission if the answer is not 
filled in.  
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Type Checking Property 

The data type of an edit box can be alphabetic, alphabetic-numeric, currency, 
date, number, phone and email.  
 

• Alphabetic –  only alphabetic value is allowed, Maximum and minimum 

length can be specified. 
• Alphabetic-numeric – each character can be either alphabetic or 

numeric. Maximum and minimum length can be specified. 
• Currency – the value is positive without currency sign, name or ISO 

code. It must be comma separated at thousands. A decimal point (.) is 
required. 

• Date – three formats are supplied. The format can be dd/mm/yyyy, 

mm/dd/yyyy or yyyy/mm/dd. 
• Number – each character should be numeric. Large Than and Less 

Than can be set. If any attribute is checked, this text must have value. 
• Phone – two options are supplied. People enter phone in different way. 

For US phone, it accepts either dashes between area code, prefix code 
and suffix like ###-###-#### or parentheses on area code followed by 
space like (###) ###-#### . For International phone, a country code is 
needed. It’s hyphen separated with optional dash between prefix and 
suffix code.  

• Email –  it contains at least one character, then a @ symbol followed by 

at least one character, then a dot (.), then at least one character. 
 
 

Setting Checkbox Properties 
 
If the question allows recipients to make multiple choices, you can use the 
Checkbox select type. You can add up to 10 checkboxes at one time. Or by 
simply clicking the icon next to Edit Label, an Answer Library dialog box will 
appear. It lists predefined answer types that if selected will be added to your 
answers for the current question. 
 
Set the font and color of the label from the Font page. You also can change the 
font and color of all checked nodes in the design tree. On the Position page, 
adjust the alignment and layout of select items. Alignment makes the select 
item appear on the left, right or center of the page. Checking Next To Previous 
will place this select item on horizontal pane next to the previous select item for 
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the current question. 
 

Setting Radio Properties 
 
If the question allows recipients to make only one choice from a number of 
possible selections  then the Radio select type can be used. You can add up to 
10 checkboxes at one time. Or by simply clicking the icon next to Edit Label, an 
Answer Library dialog box will appear. It lists predefined answer types that if 
selected will be added to your answers for the current question. 
 
Set the font and color of the label from the Font page. You also can change the 
font and color of all checked nodes in the design tree. On the Position page, 
adjust the alignment and layout of select items. Alignment makes the select 
item appear on the left, right or center of the page. Checking Next To Previous 
will place this select item on horizontal pane next to the previous select item for 
the current question. 
 

Setting List Properties 
 
The List select type is similar to the Radio select type in that only one answer 
from a selection is allowed. However, it has a more compact design that can 
save space if the number of possible selections is large. 
 
On the General page a label for the list can be entered if desired. Enter list 
items from the List Items page. Each list item must be entered on a separate 
line. List items may contain spaces. Or by simply clicking the icon next to Edit 
Label, an Answer Library dialog box will appear. It lists predefined answer 
types that if selected will be added to your answers for the current question. 
 
Set the font and color of the label from the Font page. You also can change the 
font and color of all checked nodes in the design tree. On the Position page, 
adjust the alignment and layout of select items. Alignment makes the select 
item appear on the left, right or center of the page. Checking Next To Previous 
will place this select item on horizontal pane next to the previous select item for 
the current question. 
 

Setting Matrix Properties 
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For grouping related questions together the Matrix select type can be used. 
This type of select item lays out questions in a grid. Up to 100 questions and 
possible answers for those questions can exist in a matrix at one time. 
 
After adding a matrix it is possible to directly edit the labels for the questions 
and answers on the property page. The answer type can be either checkboxes 
or radio buttons . The answer labels can use built-in values by clicking the icon 
next to the Edit Labels box. An Answer Library dialog box, which includes 
general answers, will appear. Once selected, the default values of the type 
selected will be used as labels for the question answers. 
 
Set the font and color of all labels from the Font page. You also can change the 
font and color of all checked nodes in the design tree. 
 

Setting TextArea Properties 
 
With TextArea, it is possible for the recipient of your questionnaire to type any 
extended response to a question. For example a comment about something. 
  
Use the General page on the property form to set number of TextArea’s and 
edit their descriptive  labels. Set the font and color of the label from the Font 
page. You also can change the font and color of all checked nodes in the 
design tree.  
 
On Position property page, adjust the alignment and layout of TextArea item. 
On the Position page, adjust the alignment and layout of select items. 
Alignment makes the select item appear on the left, right or center of the page. 
Checking Next To Previous will place this select item on the horizontal pane 
next to the previous select item for the current question. The size of the 
TextArea can be adjusted to suit the questionnaire layout. The dimensions 
should be specified in pixels. 
 
Must have answer —  Disable the questionnaire submission if the answer is not 
filled in.  
 

Publish questionnaires.  
  
WQ could export the questionnaire to HTML files, or it could invoke the 
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Microsoft Publish Wizard to transfer the HTML files to your website directly.  
This could be done via WQ Menu, Form=>Publish to Websites, or 
Form=>Publish to files.  
  
Publish to Websites  

WQ could publish the questionnaire directly to your websites via Microsoft 
Publish Wizard. It supports four publishing methods: HTTP Post, ftp, FrontPage 
Extended Web, Microsoft Replication System and Automatically Select Service 
Provider. If you are not sure what your web server supports, you may need to 
contact your ISP vendors, or you could use Publish to files first then upload the 
files to your websites.  
  
Publish to files.  

The questionnaire will be generated to the directory you specified. WQ does 
not generate any PHP/ASP/JSP files, which means that your web server does 
not need to install these components. As long as your web server support 
HTML files, your questionnaire could be successfully rendered. 
 

Submit the Questionnaire  
  
After the submission of the questionnaire, a thank you page will display to notify 
that the reply is successfully sent.  
 

“Thank you” page displayed after user submit the questionnaire 

  

  

If your WQ is not registered, the formmail gateway will be disabled after 100 
email replies. The submission will result in a warning page to notify you about 
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this.  
  

Warning message for unregistered users  

 
 
Response Validation 

 
Response validation makes sure that respondents have filled out the surveys 
correctly before submitting the replies to the server. The validation includes 
required response validation, data type and format checks, and range checks. 
 
Required Response Validation 

If a question must have answer, at least one of select items under the question 
node should be answered. Some of select types have ‘reply must have value’ 
attribute. They can be Text, TextArea, Checkbox, List, or Multiple Selection. 
Generally, a checkbox with ‘reply must have value’ is used to make sure that 
the respondents have read the term and agree it. 
 
If the attribute is checked, the reply must have value. If required responses 
aren’t answered, an alert message will be popped up. 
 
Text Response Validation 

With text responses validation, you’ll increase the quality of the reply by 
avoiding invalid data. A text box can be the type of alphabetic, 
alphabetic-numeric, currency, date, number, phone and email. If the date type, 
format or range is incorrect, a message will be shown to describe what kind of 
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data is proper. 
 

• Alphabetic –  the length might be validated according to the specified 

maximum and minimum length. Too short or too long is not allowed. 
• Alphabetic-numeric – each character can be either alphabetic or 

numeric. The valid length might be checked. It should meet the 
specified length criteria. 

• Currency – It must be comma separated at thousands. A decimal point 

(.) is required but it accepts zero number after the point. The number of 
decimals is unlimited. 

• Date – three formats are supplied. The format can be dd/mm/yyyy, 

mm/dd/yyyy or yyyy/mm/dd. The month (mm) should not be greater 
than 12, and the day (dd) should not be greater than 31. If the value is 
less than 10, single character can be accepted. 

• Number – each character should be numeric. The check rule can be 

only greater than or less than. It can also range between lower bound 
and upper bound. 

• Phone – two options are supplied. People enter phone in different way. 

For US phone, it accepts either dashes between area code, prefix code 
and suffix like ###-###-#### or parentheses on area code followed by 
space like (###) ###-#### . For International phone, a country code is 
needed. It’s hyphen separated with optional dash between prefix and 
suffix code.  

• Email –  it contains at least one character, then a @ symbol followed by 

at least one character, then a dot (.), then at least one character. This 
check rule can’t filter out all invalid email strings but it makes sure that 
the value matches the format of email. 
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Customization  
  
Question Library  

The same questions are often repeated when designing questionnaires. To 
avoid repeatedly constructing questions, Web Questionnaire allows adding 
questions to the question library. This can save time by avoiding the need to 
construct the same question layouts again and again. To add a question to the 
question library simply right click on the question, then select Add Into Question 
Library.   

  
Add the question to Question Library  

 

 
Adding questions from the question library is easy. Right click on the page 
nodes in the tree layout view and select the Question Library command. You 
can edit the questions in the question library any time by selecting the Edit User 
Defined Library command from the file menu.  
  

Insert question from Question Library 

  
 
Apply HTML Templates  

There are dozens of HTML templates available. It can be set in Form menu 
then choose Apply Template.   
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Export page to Html  

You can also export the questionnaire to html by selecting the asterisk (*) in the 
panel at the top of the questionnaire layout view. Then from the Form menu 
select Export Page to Html. Individual pages can be exported by selecting the 
page number you want rather than the asterisk (all pages).  

 
Import HTML templates  
  
WQ could import HTML files from your disk as HTML templates. However, 
there are several limitations regarding how the HTML is composed:  
-Cannot use external CSS (Cascading Style Sheets) files.  
-Cannot use JavaScript.  
Also, you will need to add a tag manually in order to notify WQ to place the 
questionnaire generated. The special tag is [# Insert_Questionnaire #].  

WQ will look for the tag in the template, replace it with the questionnaire while 
keeping all the style/font settings in the template intact.  
If successful, the new template will be placed along with other templates. You 
could then choose Apply Template to use the new template.  
  
There are two ways to import HTML template.  
From Menu, Form=>Apply Template  

Import HTML Template  

 
 
From Menu, Form=>Import Templates  

Import HTML Template  
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Scores Feature 
 
In addition to feedback collection, you might need quantitative evaluation of 
study, course, satisfaction, performance, service, health or personality profile. 
Score feature provides an efficient index for survey designer. With setup 
scores, evaluation forms can be easily conducted. To setup score, use the 
Setup Score command from Form menu in Questionnaire view.   
 
Specify default scores and optimal answers 

All questions of the current questionnaire are listed in the Score dialog. For 
each question, you can specify a default score and optimal response. Default 
Score is the maximum value the question can get. Optimal Answer is 

generally the correct or optimal response to the question, and assigned the 
default score. 
 

Specity default scores and optimal answers 
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Once a value is set, all assigned default scores will be automatically summed 
and displayed as the current score. Target score finally should be equal to 

current score, or the background color of current score will change from blue to 
red. 
 
Add more answers setting 

Each question can have more answers and is allowed to setup scores for each 
answer. In More Answers dialog, the default score value and optimal answer if 
any are shown in the top of the window. Then add as many score assignments 
as preferred answers. For each assignment, the score value can’t be greater 
than the default score. 
 

Add more answers setting 

 
 
Score the replies of survey participants 

Based on individual question scores and optimal answers assignment, Web 
Questionnaire compares actual responses with to derive the score. 
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For each question, any responses matching to the assigned answer options 
can have an associative score value. The highest one of them is regarded as 
the actual score that the question gets. A sum of each question score is the 
total score the participant can get. The calculated score is integrated into the 
score column of the reply table in Survey View. 
 
In Data View, an individual view of recipients’ replies is exactly presented. 
Each question is annotated with correct or wrong symbol, and the obtained 
score/default score. The question responses including one of assigned answer 
options will be marked a right symbol, or wrong symbol. 
 

Scores in Data View 
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Survey View 

All questionnaires active and finished are listed in the top window of the Survey 
View. The survey title, end time, open period and total number of replies are 
listed. Selecting a questionnaire will show the recipients in the right hand 
window. 
 
Remove Selected Replies  

WQ allows you to remove redundant replies. You could select the entries you 
want to remove, then from Menu, Survey=>Remove Selected Replies.  
  
Extend End Time  
Choose Extend End Time from Survey menu or icon on the toolbar. You can 
also right click on the questionnaire and chose the Extend End Time 

command.  
Use the End Date page to set the survey end date and if multiple replies from 
the same recipient are allowed.  
  
Export to Excel/CSV files  
Choose Export from Survey menu, there are two options, Excel or Tab 
Delimited files.  

 
Stop Survey  
Choose Stop Survey from Survey menu, or right click on the questionnaire 
and select Stop Survey.  

The survey can be stopped before its scheduled end time. All questionnaires 
can be extended when completed or prematurely halted. Refer to the Extend 
End Time command.  

  
Delete Survey  
Choose Delete Survey from Survey menu, or right click on the questionnaire 
and select Remove Survey.  

Use this command to remove the survey if it is no longer required. Once 
deleted, you could still see the deleted survey using “Display deleted survey”. 
However, if you choose to delete a previously deleted survey, it will be deleted 
permanently.  
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Undelete Survey 

Use this command to undelete a survey.  
 
Display deleted survey 

Use this command to see all surveys including deleted ones. 
 
Collect Replies  

Choose Remove Survey from Survey menu, or icon on the toolbar. This will 
collect email replies directly from the POP3 mail server or from Outlook 
Express assuming these questionnaire response retrieval methods have been 
enabled from the Tools/Options menu command.  
  
Send Invitation Emails  

In order to send out invitation emails, you will need to enter the message body 
first, along with the email subject. After that, choose an appropriate way to add 
recipients’ email address.  
 

Enter the subject and body for the invitation email.  

 

 
There are several file formats that you could import and add as the 
questionnaire recipients.   
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1. Select from Windows Address Book.  
Windows Address Book (WAB) is the one that Outlook Express uses. If you 
are using Outlook Express as your email clients, you could invoke its address 
book and select the recipients from it.   
 
2. Import from CSV files.   
The CSV ("Comma Separated Value") file format is often used to exchange 
data between disparate applications. Outlook also supports this format, which 
means you could export your contacts to csv files and import with EQ. You 
should use CSV files in favor of Excel files since it uses less memory during 
the import process.  
 
3. Import from Excel files.  
This is the file format used by Excel. Use this file format if you have your email 
addresses stored in your Excel’s worksheets.  
 

Select the recipient to send out the emails.  
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Report View 

After dispatching the questionnaire, recipients will fill out the form and submit 
the reply via the submit button on the questionnaire form. Replies will 
automatically be collected by Web Questionnaire and added to the result 
database. Before Web Questionnaire can gather replies the mail server 
options need to be correctly set. See Mail Settings, Send Format and Reply 
Method for more information on how to do this.   
  
WQ can read the replies directly from the POP3 mail server. See the 
Tools/options menu command. Then select the Mail Settings/Incoming Mail 
property page. The polling frequency can be set from this page. In addition, 
Web Questionnaire can read questionnaire replies from popular email clients. 
Currently Outlook, Outlook Express and Eudora are supported. See the Mail 
Add-In property page.  
  
If Outlook or Eudora is used, replies will be automatically redirected to WQ 
when they arrive to your inbox.   
  
If Outlook Express is used, WQ will periodically poll Outlook Express mailbox 
for questionnaire replies.   
  
Clicking Collect Replies on the toolbar will poll the pop3 mail server or Outlook 
Express for replies assuming these retrieval methods are used. Using Collect 
Replies on Survey/Report menu in Survey/Report view has the same effect.   
 
Selecting a questionnaire in the Survey or Report view will display the results 
in either a tabular view or a report view. The Survey view will contain each 
reply received, the individual responses to each question are shown. One row 
in the grid corresponds to one reply to the questionnaire. You can export the 
data to Excel or a tab delimited text file format for further analysis. To use this 
feature switch to either the Survey or Report view and choose the Export 
command from the Survey or Report menu.  
  
The Report view shows a summary of the replies received. It provides a 
graphical HTML based report. After selecting a questionnaire, the real-time 
online report is displayed for that questionnaire. The report is constantly 
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updated as questionnaire responses are received by Web Questionnaire. The 
type of chart (bar, chart … ) shown can be changed from the Report/Chart 
menu. Use the Export Report To HTML command from the Report menu to 
export the report from the Web Questionnaire database.  
 
HTML report 
 

 Display the questionnaire result in HTML format.  
 

HTML report example 

 

 
Graphic Report 
 

There are several kinds of graphic reports that you could use. This could be 
changed in Report/Chart menu. The available options are: Bar, Bar3D, Pie, 
Pie3D, Line, Line3D.  

Bar Bar3D 
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Pie Pie3D 

  

Line Line3D 

  

 



CompressWeb Inc. 

http://www.compressweb.com 34 

Data View 

Data View provides the capability to recreate the orignial questionnaire 
submission. In addition to the questionnaire body, Data View combines the 
questoinnaire reply and displays the same output just before the recipient 
submits. You could then print or save the submission. 

A navigation control panel is provided in the Data View. You could use the 
panel to browse through the submissions, search for a specific reply. You could 
also manipulate the replies using the insert/delete/update buttons. 

 

Add Reply 

Choose Add Reply from the Data menu, or the  icon on the work area. 

This will add a blank reply to the result database. If you are conducting a 
phone survey, or you need to enter the survey result manually, you will need to 
add a reply first. The new reply will be place in the 1st in the result database. 

Delete Reply 

Choose Delete Reply from the Data menu, or the  icon on the work area. 

This will delete the selected reply. A dialog will be presented to ask you 
whether you want to remove this reply or not. Once deleted, the reply could not 
be recovered. 

Update Reply 

Choose the  icon on the control panel. 

When you need to modify the reply, you will need to first answer the 
questionnaire as usual. After that all answers have been entered, instead of 
clicking on the submit button in the questionnaire, click on the update button in 
the control panel to commit the changes. If there is any field that has the “must 
have answer” property enabled, you will need to enter the answers before you 
could update the reply. 

Goto Reply 

Choose Goto Reply from the Data menu, or the  icon on the work area. 
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This allows you to jump to a specific reply instantly.  

Find Reply 

Enter the email address that you are looking for, then click the  icon to find. 

When there are huge amount of replies in the result database, Find Reply 
helps you to locate specific reply quickly. The search string you entered could 
use wildcards to represent any characters.  

A wildcard is a character that may be used in a search term to represent one or 
more other characters.  The two most commonly used wildcards are the 
question mark (“?”) and an asterisk (“*”). 
The question mark (“?”) may be used to represent a single alphanumeric 
character in a search expression.  For example, searching for the term 
“ho?se” would yield results which contain such words as “house” and “horse”.  
An asterisk (“*”) may be used to specify zero or more alphanumeric characters. 
For example, searching  for the term “h*s” would yield results which contain 
such words as “his”, “homes”, “houses”.  
 
Export the result to HTML 

Choose Export Data to HTML from the Data menu. 

After viewing the individual reply, you could choose to save it to disk, then send 
it to others or backup it for later use. 

 

Print the result in HTML 

Choose Print from the File menu. 

Since the Data View provides the same output as recipient’s submission, you 
could print the result to in order to have further processing.  
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Command Reference 

Menus 

 
Files menu: 

New Create a new questionnaire 
Open Open an existing questionnaire 
Save Save the opened questionnaire with its current file name 
Save As Save the opened questionnaire with a specified file name 
Edit User Defined 
Question Library 

Edit user defined questions in the library 

Print Print the view in the main window 
Print Preview Display the view as it would appear when printed 
Print Setup Select a printer and a printer connection 
Exit Exit Web Questionnaire 
 
Edit menu: 

Copy Copy questionnaire components 
Paste Paste questionnaire components 
 
View menu: 

Toolbars Manage the toolbar by Toolbar command 
Views Switch to different view (Questionnaire View, Survey View, 

Report View or Data View) 
Work Space Show or hide the work space 
Status Bar Show or hide the status bar 
 
Tools menu: Configuring Web Questionnaire. 

Options …  Global Options setting 
 

Help menu: Getting help and information. 

Help Topics Offers you an index to topics on which you can get help 
Online Help Get more information in our website 
Online Support Send an email to the product supporter 
About Display the version number of this application 
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Form/Survey/Report/Data menus 

 
Form menu: Only displays in Questionnaire view. 

 
Publish to Web 
Site 

Publish the questionnaire directly to your websites via MS 
Publish Wizard. 

Publish to Files Generate the questionnaire to the specified directory. 
Find Text Find text in the content of the questionnaire. 
Apply Template Update the background of the questionnaire. 
Insert Template …  Use the custom template as the background of the 

questionnaire. 
Setup Score Set scores to the questions of the current questionnaire. 
 
Common menu items for Survey/Report/Data view 

Send Invitation 
Email 

Send email to invite the recipients to reply the survey in the 
website. 

Extend End Time Extend the survey end time. 
Stop Survey Stop to accept replies of the currently active survey. 
Remove Survey Remove the replies from database. 
Undelete Survey Undelete the selected deleted surveys. 
Display Deleted 
Survey 

Display all surveys including all deleted. 

Setup Score Set the scores to questions. 
 
Survey menu: Only displays in Survey view 

 
Export Export replies to Excel file or CSV file. 
Save as Fdb Save the selected survey published previously for reuse. 
Collect Replies Check for replies from pop3 server or Outlook Express 

immediately 
Remove Selected 
Replies 

Remove selected replies which might be testing or 
duplicated replies. 

Display The single selection reply can be display as Value or as 
Text. 

 
Report menu: Only displays in Report view. 

 
Chart Select the presentation format of Graphic Report 
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Export Report to 
Html 

Export report to html file 

Collect Replies Collect replies from pop3 server or Outlook Express 
immediately 

 
Data menu: Only displays in Data view. 

 
Add Reply Enter a blank reply to result database to allow you enter 

results manually. 
Delete Reply Delete the selected response 
Go to Reply Jump to the specific reply instantly 
Export Data to 
Html 

Save the current reply to disk as HTML format 

 


